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1.Introduction

1.1Purpose and Scope.

The THEMIS analysis software is derived from an IDL set of routines that operate on CDFs from existing
missions such as Cluster, Wind, Polar and FAST. This software is being re-organized by the THEMIS
software developers and scientists, and checked into a software management database—using the freeware
Subversion (SVN)—for maintenance, tracking updates and contributions by a distributed team, and
ensuring self-compatibility. In addition to the command-line invoked IDL routines, a graphical user
interface that prompts the user for opening, analyzing and plotting the THEMIS data is being developed,
and is intended to facilitate use of the most useful of the THEMIS routines.

1.2Applicable Documents.

1. THM_SYS 012 PDMP THEMIS Project Data Management Plan

2. THM SOC 101 TIME THEMIS TIME Definition

3. THM_SOC 108 GMAG L1 VARNAMES THEMIS GMAG Variable Name Def’s

4. THM SOC 111 SUNSENSPROC THEMIS SUN SENSOR Science
Processing

5. THM SOC 112 ATTPAIPROC THEMIS Science ATT & Inertia Determ.

6. THM SOC 113 FGM_CALPROC THEMIS FGM CAL File and Processing

7. THM_SOC 114 SCM_CALPROC THEMIS SCM CAL File and Processing

8. THM_SOC 115 _EFI CALPROC THEMIS EFI CAL File and Processing

9. THM_SOC 116 ESA CALPROC THEMIS ESA CAL File and Processing

10. THM_SOC 117 SST CALPROC THEMIS SST CAL File and Processing

11. SAI-SPEC-1079A (Oct 26, 2005) THEMIS Coordinate systems

12. SAI-RPT-0722a (September, 2006) Probe Alignment Report (MSSS data, p18)

13. pturin e-mail on Faro alignment results (9/28/06) FGM, SCM mag alignments
14. THM-MB-MEC-005-Magnetometer clocking r7.pdf MAG clocking angles
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2.Brief Overview of the Software

The THEMIS Data Analysis Software (hereafter referred to as THMSW) is IDL-based. THMSW routines
can be used to download, open, analyze and plot L1 or L2 data and process L1 data into L2 data quantities.
There are two main ways to use the programs: with the command line interface, or with the GUI interface.

Future features will include the ability to create L2 data files the L2 data quantities, utility routines to
translate data into other products (e.g., ascii) as necessary.

2.1How to Get Started

Assuming you have the software installed, the best place to start is with a crib sheet. The crib sheets in the
idl/themis/examples folder give end-to-end examples of how to load, process and plot the highest level data
available for a given instrument.

Crib sheets in idl/themis/examples:

thm crib_gmag Crib sheet for GMAG, including wavelet demo.

thm_crib_mom Crib sheet for particle Moments.

thm crib_sst Crib sheet for Solid State Telescope.

thm crib_fgm Crib sheet for Flux Gate Magnetometer

thm crib_scm Crib sheet for Search Coil Magnetometer — Linux or Windows, only.
thm_crib_efi Crib sheet for Electric Fields Instrument.

thm crib_fbk Crib sheet for Filter Bank.

thm crib_scm Crib sheet for Search Coil Magnetometer — Linux or Windows, only.

thm crib_asi Crib sheet for loading and displaying All Sky Keogram data.

thm_crib_tplot Crib sheet for using tplot plotting package, using GMAG data as an example.

You can run any of the crib sheets by typing
.run <thmerib_xxx>

when execution stops at a 'stop' command in the crib sheet, type
. C

to continue.
Alternatively, you can cut and paste from the crib sheet to the command line.

To find more information on any of the THMSW routines used in the crib sheets, use:

e The source code of the crib sheets, which is included in the idl/themis/examples directory of the
software distribution.

e HTML help included with the software distribution

e IDL XDOC widget. At the IDL prompt, type:
xdoc

e IDL doc library procedure. At the IDL prompt, type:
doc_library, ‘command name’

Sample THEMIS routine documentation:

+
;Procedure: THM_LOAD_GMAG,
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; thm_load_gmag, site = site, datatype = datatype, trange = trange, $
; level = level, verbose = verbose, $
; subtract_average = subtract_average, $
; subtract_median = subtract_median, $
; varname_out = varname_out, $
; subtracted_values = subtracted_values, $
; downloadonly = downloadonly, $
; valid_names = valid_names
;keywords:
; site = Observatory name, example, thm_load_gmag, site = 'bmis’, the
; default is 'all', i.e., load all available stations . This
; can be an array of strings, e.g., ['bmls', ‘ccmv'] or a

single string delimited by spaces, e.g., 'bmls ccnv'
; datatype = The type of data to be loaded, for this case, there is only
; one option, the default value of 'magd', so this is a
; placeholder should there be more that one data type. 'all'
; can be passed in also, to get all variables.
TRANGE-= (Optional) Time range of interest (2 element array), if

this is not set, the default is to prompt the user. Note
that if the input time range is not a full day, a full
; day's data is loaded
; level = the level of the data, the default is 12, or level-2
data. A string (e.g., 'I2") or an integer can be used. 'all'
; can be passed in also, to get all levels.
; IVERBOSE : set to output some useful info
/SUBTRACT_AVERAGE, if set, then the average values are subtracted
; from the loaded variables,
; ISUBTRACT_MEDIAN, if set, then the median values are subtracted
; from the loaded variables,
varname_out= a string array containing the tplot variable names for
the loaded data, useful for the following keyword:

subtracted_values = returns N_elements(varname_out) by 3 array
; containing the average or median (or 0) values
; subtracted from the data.
/downloadonly, if set, then only download the data, do not load it
; into variables.
; /valid_names, if set, then this will return the valid site, datatype
; and/or level options in named variables, for example,

thm_load_gmag, site = xxx, /valid_names

; will return the array of valid sites in the
; variable xxx

;Example:
thm_load_gmag, site = 'bmis', trange =
['2007-01-22/00:00:00','2007-01-24/00:00:00"

;Written by: Davin Larson, Dec 2006

; 22-jan-2007, jmm, jimm@ssl.berkeley.edu rewrote argument list, added

; keywords,

; 1-feb-2007, jmm, added subtract_median, subtracted_value keywords

; $LastChangedBy: kenb-mac $

; $LastChangedDate: 2007-02-05 22:58:50 -0500 (Mon, 05 Feb 2007) $

; $LastChangedRevision: 303 $

; SURL:
svn+ssh://thmsvn@ambrosia.ssl.berkeley.edu/repos/thmsoc/trunk/idl/themis/ground/thm_load_gmag.pro $

2.2Availability of Code and Documentation.
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2.2.1Tested Software Releases

Zipped and tested code releases along with corresponding documentation are available in release folders
which can be found at the following URL:

http://themis.ssl.berkeley.edu/socware

For example, the latest release as of the writing of this document is in:

http://themis.ssl.berkeley.edu/socware/thmsw_1_0_20070213/

Each release folder contains

¢ idl folder for browsing the source and documentation.

»  zip file for download of entire contents of the idl folder.

e  doc folder containing the version of this document corresponding to the released software.
The zip file includes IDL files and HTML documentation. HTML-browsable documentation of the IDL
routines is available within each release folder at idl/thmsw_doc.html.

2.2.2L atest Software Under Development

The latest THEMIS code being developed and/or integrated at the THEMIS SOC is visible at
http://themis.ssl.berkeley.edu/socware/bleeding_edge. The idl subdirectory of bleeding_edge is a link to
/disks/socware/idl, which is the integration/testing area for the latest data analysis software at UCB SSL.
There is no guarantee that the software and/or HTML documentation available for browsing is the most up-
to-date version available at any given time. The /disks/socware/idl workspace can be made up-to-date and
a snapshot can be created on demand, to allow access to the latest THEMIS software. The software
included in these snapshots is made available without warranty or guarantee. The snapshots will be
available as zip files within the bleeding_edge folder. Each snapshot zip file contains the complete set of
IDL source files and corresponding automatically generated HTML documentation. The snapshot file
name corresponds to the SVN revision number and date of the last change that was committed to the
THEMIS SVN repository at the time the snapshot was made.

Even more up-to-date and detailed access to the THEMIS code will be available through a web interface to
the SVN repository (read-only) http:// or svn:// URL to be determined. This is for access to the very latest
version of the code, plus possibly access to the SVN change log.

2.3Graphical User Interface

The philosophy of the graphical user interface GUI is to provide a convenient interface to the most
generally useful capabilities of the command-line THEMIS IDL routines. General users can use the GUI
without being required to know the individual IDL routines. However, users who want a jump-start to
using the more powerful and customizable IDL programming interface may begin with the GUI and then
use the GUI to generate a script of the underlying IDL commands which perform the same function. This
script can then be used as a starting point for creating an IDL program to process THEMIS data, or can be
used as a crib sheet for using the THEMIS IDL programming interface.

The GUI code is bundled together with the THEMIS IDL code distribution, they are downloaded and
installed as a single package.

Documentation for the GUI are found within the software distribution at idl/themis/examples/thm _gui.txt.

In the future, we hope to make the GUI available as an IDL save file runnable on the IDL Virtual Machine.
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3.User’s Guide

3.1System Requirements

The THEMIS Data Analysis Software requires IDL on Windows or a UNIX-like operating system like
Solaris, Linux, or Mac OS X. You must have IDL 6.3 to read the THEMIS CDF data files. Alternatively,
you can use an earlier version of IDL, and apply the patch available at
http://cdf.gsfc.nasa.gov/html/idl62 or earlier and cdf3 problems.html

Even if you have IDL 6.3, you will want to install the patch if you use IDL to write CDF files. This is
because of a bug in IDL 6.3 which will be fixed in 6.4.

Mac OS X notes:

You need X11 to view plots and use the GUI in IDL. You can search for X11 in the Spotlight to
see if the X11 application is installed on your system. X11 is available on your Mac installation
disks, but may not be installed by default.

There is a known problem, mentioned in the IDL 6.3 release notes, which affects all IDL users
running Mac OS 10.4 (Tiger) The tlimit command will lock up IDL because the plot window will
not receive any mouse clicks.
Workaround: Change the X11 start-up parameters. Do the following:
1. Open any terminal window (in the X11 application menu bar, you can choose xterm from the

applications menu)
2. Enter the following at the shell prompt:

defaults write com.apple.x11 wm_click through -bool true

3. Quit X11 (if it is running).
The new default will take effect the next time you start X11, and it will persist from that point
(i.e., you will not have to make the change again).

3.2Installation and configuration.

Getting started is usually as simple as of downloading the code and setting up your IDL path, according to
the instructions, below.

You can download the code from the locations described above in Availabililty of Code and
Documentation.

Once you've downloaded the zip file, choose a location where you want to place the software directory
heirarchy.

Unzip the .zip file. It will create a folder with the same name as the zip file. The folder will contain an idl
directory.

3.2.1.1IDL PATH setup

3.2.1.1.1IDL PATH Setup on Windows (and IDLDE on UNIX, Linux and Mac)

NAS5-02099 File: thm_soc_120_ANALYSIS SFW_USERS GUIDE.doc 2/13/2007 01:09:09 A2/P2 9
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For Windows or IDLDE on UNIX, you can use the File->Preferences widget to set up the path so IDL can
find the THEMIS IDL files.

UNIX Note: If you use IDLDE on UNIX-like systems, these instructions only work if you do not
set the IDL_PATH environment variable before you call IDLDE. If IDLDE does not allow you to
set the path by following these instructions, then follow the instructions for UNIX installation,
below.

Start IDL (Windows) or IDLDE (UNIX, Linux, Mac).

Go to File->Preferences
Select the ‘Path’ tab.

If <IDL DEFAULT> is not present, press ‘Insert Standard Libraries’

Press Insert
Browse to find your installation and select the ‘idl/external’ directory
Check the box to indicate “search subdirectories”

Press Insert
Browse to find your installation and select the ‘idl/ssl_general’ directory
Check the box to indicate “search subdirectories”

Verify that ‘id]l_external’ is last in the list.

Press Insert
Browse to find your installation and select the ‘idl/themis’ directory
Check the box to indicate “search subdirectories”

3.2.1.1.2IDL PATH Setup for IDL Command Line (UNIX, Linux or Mac OS X)

For the command line version of IDL, installation consists of setting up the IDL_PATH environment
variable. The THEMIS Data Analysis Software distribution includes setup scripts, which help set the
IDL PATH variable correctly.

If you use csh or tesh, the recommendation is to put the following in your .cshre
setenv |DL_BASE DI R /path/to/thmsw_v_sb_yyyymudd/i dl
source $I DL_BASE DI R/t hem s/ setup_them s

If you use bash shell, the recommendation is to put the following in your .bashrc (Linux) or .bash_profile

(Mac)
| DL_BASE DI R=/ path/to/thmsw_v_sb_yyyymdd/i dl
. $IDL_BASE DI R/t hem s/ setup_t hem s_bash

In the above examples, IDL_BASE DIR should be set to the full path name to the idl directory inside the
THEMIS Data Analysis Software release.

3.2.1.2Data Directory Setup

The THEMIS Data Analysis Software requires a local data directory in which THEMIS data files can be
cached. The THEMIS will attempt to create the local data directory for you at the following default
location, depending on your operating system.

NAS5-02099 File: thm_soc_120_ANALYSIS SFW_USERS GUIDE.doc 2/13/2007 01:09:09 A2/P2 1
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0S LOCAL DATA DIR
Windows C:\data\themis
Solaris, Linux, Mac OS X ~/data/themis

These locations should

work as-is for most installations; however, if you don’t have administrative

privileges to create the data directory in the above locations, you can have your system administrator create
it for you, or you can configure the THEMIS Data Analysis Software to use an alternate location. See
Remote Data Access and Local Data Cache for information about configuring an alternate location.

3.2.2Loading THEMIS Data

The THEMIS software
THEMIS data archive.

will automatically create a local data cache which mirrors the structure of the
The software is written such that the default settings will work for the majority of

users. The location of the THEMIS data archive is also found automatically by the software.

To download some data and load it into IDL, you simply specify a timespan and type of data you want to

load. If the data does n
is loaded into IDL.

3.2.2.1Loading Data

ot exist locally on your local data_dir, it will be downloaded automatically before it

With the GUI

At the IDL prompt, type

t hm_gui
Select a timespan, data

type, and satellite or ground station. Use the control key to select more than one

item the menus. Press the Load button to load the data.

3.2.2.2L oading Data

from the IDL Command Line

At the IDL prompt, type:

ti mespan,

' 2006-11-11",

1, /day

Then, use one of the thm_load commands, e.g.

thm | oad_gmag,

site='ccnv'

Examples of routines for loading data:

thm load mom loads moments data

thm load efi loads efi waveforms

thm load fgm loads all fgm waveforms (choice of fgl, fgh...)
thm load scm loads SCM waveform.

thm_load gmag

loads ground mag data for any ground station (by keyword) or all available.
Keywords to choose high lat and low lat.

thm_load hsk

loads housekeeping data — all or one by keyword. Important for FGM
(temperatures) but also other instruments. Not implemented yet.

Standard Load Procedure Keywords:

SITE string: ground station name, or a list of ground station names, or ‘all’
PROBE string: probe name, or a list of probe names, or ‘all’. e.g. ‘abc’
DATATYPE type of CDF file for the given instrument.

LEVEL Level of data file to load: 11" or '12'

VERSION Version of CDF file to load (useful for STATE data): 'v01', 'v02'

NAS5-02099 File: thm_soc_120_ANALYSIS SFW_USERS GUIDE.doc 2/13/2007 01:09:09 A2/P2
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3.2.3PIot your first plots of ground or space data

In the GUI, press ‘Process Data/Tplot’
You can select the data quantities you want to plot from the ‘Loaded Data’ list.

In the command line, type

t pl ot _nanes

to see available data quantities. Type, e.g.,

tplot, 1

to plot the first quantity.

tplot, [1,2,3]

plots a stack plot of the first 3 data quantities.

Plotting routines:

tplot

General purpose time plotting utility for creating stack plots of waveforms and
sonograms.

tlimit Zoom into or out of a tplot

get _data Get data out of a tplot variable into a structure containing a time tag array and a data
array.

store data Store a data array structure into a tplot variable.

Refer to thm_crib_tplot for examples of using get data and store data.

3.2.4Calibrations

Refer to the crib sheet for each instrument for usage of the calibration routines.

Calibration: from L1 data to physical quantities

thm cal mom

calibrates all (ESA and SST) moment data

thm_cal sst calibrates SST data provides counts, eflux, flux and psd (phase space density or
distribution function) data
thm cal fit same as thm cal sst, above, but for ESA data.

Beyond calibration: combining physical quantities to create higher level data products: These routines
are not implemented yet.

thm pa sst

Combines SST psd, and FGM and provides pitch angles dist.

thm pa esa

same as above, but combines ESA and FGM.

3.2.5Coordinate Transformations

A coordianate transformation example can be found in thm_crib_fgm.pro. The coordinate transformation
routines currently work on tplot variables only.

Coordainate transformation routines include:

cotrans Transform between geophysical coordinate systems

ss12dsl Transform between spinning and despun L-vector aligned coordinate system,using
data from the STATE file.

dsl2gse Transform between despun L-vector aligned coordinate system and GSE, using data
from the STATE file.
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3.3Managing Your Data Cache
There currently exist some experimental routines for managing your THEMIS data file cache. These
routines serve as an example of how you will be able to download all data for a given time range with a
single command.
e thm file download — can be used to download all types of THEMIS data for a given time span.
e thm file cleanup — delete empty directories. This is a function call. It searches the hierarchy and
return files matching a given pattern, sorted by access time. Currently does not delete files, but
can be used as a tool for finding old data.

3.3.1Configuring Local Data Cache and Remote Access Behavior

Data locations may be configured at IDL startup (for example, if you want the data to reside in a non-
standard location), or dynamically during an IDL session.

The following table summarizes the controls that can be used, in order of precedence:
e |THEMIS system variable
e environment variable settings
e thm_config.pro

The following table summarizes the settings available:

Ithemis structure Environment Variable Description

element

local data dir THEMIS DATA DIR a writable, local directory in which to
cache data files

remote_data_dir THEMIS REMOTE DATA DIR URL to a data archive where THEMIS

data can be found. By default,
http://sprg.ssl.berkeley.edu/data/themis

no download N/A 1: don’t access remote data dir

no_update N/A 0: download only if file on server differs
or if local file does not exist.

1: download only if local file does not
exist. i.e. no clobber.

progress N/A 0: don’t show progress bar
1: show progress bar for each file
downloaded.

verbose N/A level of verbosity for themis commands,
O=silent. Values >1 are generally for
debugging.

3.3.1.1Configuration at startup

For initial configuration, you can set the environment variables specified in the above table. Depending on
your operating system and/or shell, this can be done in .bashrc, .cshre, or ‘System Properties’ Window.
Alternatively, the thm_config.pro file provides a platform-independent and more flexible way of
configuring your initial configuration.

1. Make a copy of the idl/themis/common/thm_config.pro in a directory outside the THEMIS Data
Analysis Software distribution (or edit it in place, if you don’t mind losing your changes when you
update your software)

2. Add the directory which contains your copy of thm_config.pro to your IDL PATH, making sure
that it is before the idl/themis directory. (See IDL PATH setup, above).
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3. Edit your thm_config file to set the environment variables to your liking. See the above table for
the names of relevant environment variables.

3.3.1.20n-the-Fly configuration

The local data directory location can be changed on-the-fly by setting the !themis.local data dir system
variable. For example, when you are connected to the network, you may choose to use a networked data
dir:

Ithem s.local _data_dir = ‘\\justice\data\them s\’

The remote_data_dir structure element can also be updated to a different URL.

If you want the software to use only locally available data, and don’t want the software to try to download

data, you can set:
I'them s.no_downl oad = 1

Note that you can only set the !themis variable in an IDL session after a thm command has already been
run, or after explicitly calling thm_init.

3.4General Conventions used in THMSW routines

The naming convention is that all THEMIS-specific routines begin with thm_followed by the function
(action) followed by the type of data operated upon. E.g., thm_load xxx reads xxx data.

Non THEMIS-specific routines have a generic name, such as cotrans.

Some routines operate on (as input and/or output) arrays (or structures of arrays returned by get data).
Others operate on tplot variables (i.e. handles to structures which contain data as well as information about
how to display that data in time plots), while in the future we may upgrade the routines to give an option to
do either one.

3.5Software Organization

The themis directory contains THEMIS-specific routines. The general directory (currently named
ssl_general) contains routines which are useful for more than one space-science mission for which
THEMIS team members are developing code. The external directory contains packages developed and
maintained by other groups, but which are required for writing (and running) the themis and/or general
routines.

The idl directory of the distribution includes the following files and sub-directories.

NAS5-02099 File: thm_soc_120_ANALYSIS SFW_USERS GUIDE.doc 2/13/2007 01:09:09 A2/P2 1
Page of 16



, THEMIS

thmsw_doc.html | Documentation in HTML format, including alphabetical list of all routines.

themis/ setup themis [ Sample setup script for csh (UNIX)
ground/ routines for loading, processing and plotting ground-based data. e.g.
thm load gmag, thm gmag stackplot, imageplot, mosaicplot
spacecraft/ fields/ routines for loading, processing and plotting particles
data, e.g. thm proc fgm
sst/ (Should be particles/) routines for loading, processing
and plotting particles data, e.g. thm_load_sst,
thm cal sst
state/ Routines for reading state and performing coordinate

transformations, e.g. thm_load_state, cotrans, ssl2dsl, dsl2gse.

examples/ Crib sheets, like thm crib_ask
common/ THEMIS-specific tools useful to multiple data types and
instruments, eg thm_gui, thm_file download, thm init
ssl_general/ CDF/ CDF utilities, including cdf2tplot, and other utilites like cdf2tplot,
cdf info, cdf load vars (into IDL structure representation of CDF)
science/ Routines useful for specific scientific analysis.
cotrans/ Coordinate transformations: Vectorized version of ROCOTLIB.
tplot/ General time-plotting utilites
misc/ Miscellaneous routines used by tplot and other ssl general routines.
key param/ Load routines for ACE, KP, WIND, POLAR data.
external/ SSW _gen idl | direct import of a portion of SSW general IDL routines
CDAWeb

The themis doc.html file contains a complete listing of all routines in the hierarchy, along with links to
complete documentation.

3.6How to modify code for your own use

This section gives ideas about you can move beyond the generic capability provided by the GUI and crib
sheets.

For command line-based analysis the process of creating new capability would be

Modify code generated with the thm_gui 'History' feature.

Modify existing analysis crib sheets

Write your own analysis module — an IDL routine - that operates on data
Transfer between data arrays and tplot variables

Plot the data

kW=

You can build on the basic functions of the GUI by:

1. Stringing multiple operations on a pipeline
2. Creating a new operation and corresponding GUI in your local toolkit (not yet implemented).
3. Save a pipeline into a crib sheet (transfer to command line based analysis)

a. Use the History and ‘Clear History’ buttons
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3.7How to contribute code and modifications

If you want to contribute code to the THEMIS IDL SW distribution, you can email us your routines, or you
can become part of the THEMIS development team and work directly with the SVN repository. We can
give you access if you provide us with your SSH public key. See the THEMIS SOC SW document for
details on working with the THEMIS SVN repository.
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